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1 Introduction

SIEServe™ software is a program that operates in the Microsoft® Windows™ operating
environment on a personal computer. It offers a means of collecting and displaying real-
time data from devices comprised by the Siemens ACCESS™ electrical distribution
communications system. Although SIEServe software does not offer the same
monitoring and control capability as the Siemens Power Monitor™ display and
monitoring unit, Power Monitor PC™ software, or ACCESS Host PC, it does enable you
to collect and display some of the same real-time data as these other products. In
addition, SIEServe software is capable of delivering its data to other compatible
Windows applications, also in real time. It does this through dynamic data exchange
(called DDE), a method of sharing information that is supported by a growing number of
Windows applications.

SIEServe software allows you to connect the ACCESS devices on your distribution
system, either directly or through a modem, to the ACCESS system's SEAbus
communications bus.

Note: Although Siemens provides the SIEServe software to you free of charge, be sure
to register your copy of the software on the registration card that comes with the program
diskette. Or you can call Siemens at 919-365-2120 to register by telephone. Asa
registered user, you are eligible for free upgrades to SIEServe software and for
information about Siemens' ongoing development of Windows software for its ACCESS
systems. When you register, Siemens will also send you a free video tape that
demonstrates how to use the software and how to connect other Windows applications to
SIEServe data.

1.1 About the ACCESS System

Siemens ACCESS systems comprise a variety of "smart" devices that control, monitor,
and display data from your electrical distribution system. The first level of control is in
the field where microprocessor-based tip units, power meters, protective relays, and
motor control devices also send and receive information about your system. At a second,
higher level are supervisory devices that collect information from these field devices.
Supervisory devices display the information and add the capabilities of programming,
monitoring alarms, and logging system events. Field and supervisory devices are linked
together by an industry-standard, RS-485 communications bus. Siemens' own SEAbus
communications protocol (an open protocol) defines the exchange of information over a
shielded, twisted-pair cable that links all devices. Presiding over the system is an
ACCESS host personal computer that can monitor an entire electrical system consisting
of more than 1000 devices.

SIEServe software is the newest element in this system. It lets you turn a personal
computer into a collection point for real-time data from all the field devices on your

system.



1.2 About This Manual

This manual is intended as a user's guide for SIEServe software. It contains all the
information you need to install, set up, and run the software. It also addresses other
topics related to using SIEServe software, such as dynamic data exchange (DDE) and
connecting your personal computer to the ACCESS systems and devices.

Because SIEServe software is a Windows program, you need to be somewhat familiar
with the Windows operating environment. This manual explains some Windows related
tasks at a basic level, but it does not provide detailed instructions for these tasks. If you
have not used Windows before, refer to your Windows documentation to learn the basics.
You may also need to refer to the Windows documentation as you use SIESierve
software if you have difficulty with any of the Windows tasks or terminology you
encounter along the way.

The following table tells you where to find the information you need in this manual:

If you want to know about. .. Refer to section . . .

other documentation you may need when using 1

SIEServe software

connecting your computer to an ACCESS system 2

installing the software 2

running the SIEServe demonstration program 2

navigating among device windows in your system 2

configuring SIEServe software for your ACCESS 3

system

establishing communications with your ACCESS 3

system

adding, changing, and deleting devices in the SIEServe 3
rogram

using SIEServe data in other applications 4

running multiple copies of the SIEServe program 5

using SIEServe software on a network with NetDDE 5

dynamic data exchange (DDE) Appendix A

the DDE item codes for any data quantity provided by Appendix B

SIEServe software

using SIEServe software to dial a modem Appendix C

1.3 Other Documentation You Will Need

Although SIEServe software operates as an independent application, its primary function
is to collect information from one source (the ACCESS devices on your electrical
distribution system) and then make it available for display or for other applications (such



as Microsoft Excel or Word for Windows). Because SIEServe software operates in
conjunction with so many other devices and applications, you will need to refer to their
documentation as well, to help you make the most of the information that SIEServe
software provides. And because SIEServe software runs in the Microsoft Windows
operating environment, you may need to refer to Windows documentation from time to
time. If you are not yet familiar with Windows, you need to learn the basics before you
can successfully use SIEServe software. In addition to printed documentation, Windows
comes with an on-line tutorial that leads you through a hands-on introduction on your
computer.

To connect your computer to the ACCESS field devices on your distribution system, you
need an RS-232 to RS-485 converter and the documentation that tells you how to set it
up. If you use the Siemens Isolated Multi-Drop™ converter , you need Isolated Multi-
Drop™ RS-232 to RS-485 Converter (Siemens manual no. SG-6048). If you are setting
up your network of ACCESS devices for the first time, be sure to consult the operator's
manuals for each of the ACCESS devices on your system. In addition, Installing the
ACCESS System (Siemens manual no. SG-6028) provides a detailed overview of that
process.

Finally, you may need user's manuals for other Windows applications. Because SIEServe
software makes the information it collects available to DDE client applications (like
Microsoft Excel) you will need documentation for those applications as well if you
intend to use them.



2 Getting Started with SIEServe Software
This chapter describes how to set up and begin collecting data with SIEServe software. It

tells you

what you need to run SIEServe software

how to connect your PC to an ACCESS system
how to install SIEServe software

how to run the SIEServe demonstration

the simplest way to view SIEServe data

2.1 What You Need to Run SIEServe Software

To run SIEServe software on your personal computer, you need the following hardware,
software, and minimum capability:

SIEServe program diskette

personal computer running Microsoft Windows 3.1
disk storage space of at least 3 megabytes

3.5", high-density, floppy diskette drive

a mouse supported by Windows (Although you can operate without a mouse,
most people find it easier to use one with Windows.)

RS-232 serial communications port or a modem

RS-232 to RS-485 converter, either the Siemens Isolated Multi-Drop
converter or the COM32 from Power Measurements, Ltd.)

In addition to the preceding items, you may want to consider connecting your computer,
converter, and field devices to an uninterruptible power source, to avoid any interruption
in data collection during an outage (when you may need the program the most).

2.2 Connecting Your PC to an ACCESS System

Before you can use SIEServe software to communicate with the ACCESS field devices
on your electrical distribution system, you must physically connect your computer to the
SEAbus communications loop that links those devices. SIEServe software allows you the
two options described and illustrated below for connecting your computer:



1. Use a Siemens Isolated Multi-Drop converter or a Power Measurements
COM?32 converter to connect a serial port on your computer to the
SEAbus communications loop.
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2. Use dial-up or short-haul modems and a Siemens Isolated Multi-Drop
converter or a Power Measurements COM32 converter to connect a serial
port on your computer to the SEAbus communications loop.
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For complete information on choosing the right option and on installing the Siemens
Isolated Multi-Drop converter, refer to



e Isolated Multi-Drop RS-232 to RS-485 Converter (Siemens manual no.
SG-6048) or the user's manual for the Power Measurements COM?32.

» Installing the ACCESS System (Siemens manual no. SG-6028), which
provides complete information on connecting all devices to the SEAbus
communications loop on the ACCESS system.

e user's manuals for your modems

2.3 Installing SIEServe Software

The SIEServe program diskette contains everything you need to install SIEServe
software on your PC. All you need to do is run the installation program on the diskette. It
creates a SIEServe program directory, copies all files into the directory, and creates a
Windows program group and SIEServe icons.

To install SIEServe software on your PC, start Windows and follow these steps:

1. Insert the SIEServe program diskette into your diskette drive.

2. From the File menu of Windows Program Manager, select "Run . . .", and the
Run dialog box appears:

Command Line:
il ]

: [J Run Minimized

3. In the Command Line box, type the designation of the diskette drive where
you've inserted the SIEServe diskette (either "a:" or "b:"), followed by
"setup”. Choose the OK button to complete the installation.

SIEServe software's installation program creates a default directory (C:\SIESERVE) on
your computer and a Windows program group called "Siemens ACCESS", in which it
installs program icons for the SIEServe program, the SIEServe Demo, and the Windows
Write file for this manual.

In addition to installing and setting up the SIEServe program, demonstration, and
manual, the installation also copies data files for four other applications into the default
directory: Microsoft Excel, Lotus® 1-2-3®, and Quattro® Pro spreadsheets and a
Microsoft Word for Windows document. You can open these files while running the



demonstration to see how SIEServe software provides real-time data to other applications
supporting DDE.

2.4 Running the SIEServe Demonstration Program

After installing and setting up SIEServe software, you are ready to run the demonstration
program. Even if your computer is not yet physically connected to your ACCESS
system, you can still see how SIEServe software works. As mentioned in the preceding
section, the Siemens ACCESS program group contains three items: the SIEServe
program, demonstration, and user's manual. The demonstration configuration simulates
data collection from an ACCESS system that comprises one device of each type
supported by SIEServe software. So you can see how the program operates to display
real-time data from any ACCESS device. After viewing the demonstration, read chapter
3 to learn how to configure SIEServe software to collect data from your own ACCESS
system.

To run the SIEServe demonstration and see how SIEServe software works, follow these
steps:

1. From the Windows Program Manager, open the Siemens ACCESS program
* group by double-clicking its icon with the mouse pointer.

2. Double-click the SIEServe Demo icon, and the application window appears:

Edit Communication Window Help

Type 4700 Addr 100
Amperage Phase A 3102
Phase B 3153
Phase C 3182
Average 3146
I4 o]
Voltage Phase AB 483 Phase A 278
Phase BC 484 Phase B 277
Phase CA 485 Phase C 279
Average 484 Average 278
Kw 1425
KU Dewmand 1425 Inpuc 1 Off
KVAR 45 Input 2 Off
KVA 1425 Input 3 oft
Power Factor Lag 93 Input 4 Oft
Fregquency 60.5
V.Aux. 485 Relay 1 OPERATED
KU Hours 28591725 Relay 2 Released
KW Hr Reverse 41243 Relay 3 OPERATED




Notice that within the SIEServe application window are nine device icons,
one for each type of ACCESS device supported by SIEServe software. Each
time you minimize a device window, you will see the icon for that device type
along with the device's unique name just below it. (Section 3.2 below talks
about naming devices when you add them to your SIEServe system
configuration.)

3. Double-click an icon that represents a type of device on your system, and a
window opens showing the device's real-time data. Notice that the data
changes every two or three seconds as the demo configuration emulates data
collection. If all the device data is not visible, click the Maximize button in
the upper right corner of the device window to expand it to full size.

4. Place the mouse pointer anywhere within the borders of the window, and
click the right mouse button. A list appears showing the names of all the
devices configured on your system:

33600

4 4300

9SB

6 SENIII
1sTHicp

8 SAMMS

9 4700-2

More Windows...

5. Place the mouse pointer on a device name in the list and press the left mouse
button to open that device's window. If you select "More Windows..." from
the list, the Select Window dialog box appears:

Use the scroll bar to find the name of the device whose window you want to
open. Select that name from and choose the OK button.



6. Now click the Minimize button in the upper right corner of the open device
windows to reduce them to icons.

7. Finally, when you finish viewing data, click the Minimize button in the upper
right corner of the application window to reduce the SIEServe program to an
icon in Program Manager. SIEServe software continues running in the
background and collects real-time data while you use other applications in
Windows.

Note: When you finally close the demonstration, the program may ask if you
want to "Save changed configuration?" Select "No" in response to this
question in order to leave the demonstration program intact for future
viewing.

The application window and device windows in the SIEServe program function like any
other Windows program. You can

o click the Maximize button in the upper right corner of a window to expand
the window to its maximum size

« click the Minimize button in the upper right corner of a window to reduce it
to an icon

« click the Restore button in the upper right corner of a maximized window to
return it to its previous size

« resize a window by dragging its borders and corners with the mouse

o activate the Control menu from the Control-menu box in the upper left corner
and selecting from the menu

« move a window within the application workspace by clicking on its title bar
and dragging it to a new position

Hint: On systems with a large number of devices, you may find it confusing to operate
with more than a few device windows open at the same time. Try reducing all device
windows to icons in the SIEServe application workspace. Then, one at a time, maximize
the device for which you want to view data. If you don't see a device you are looking for
in the workspace, use the scroll bars to bring its icon into view. Or place the mouse
pointer in an open window, and press the right mouse button to produce a pop-up list of
all devices in your system configuration. Then select a device from the list to open its
window and display its data.

After you take a few minutes to view the data available in the windows of devices like
those you have on your ACCESS system, you might want to look at some of the
demonstration files for other applications that come with SIEServe software. Once the
SIEServe program is running in demo mode or real-time, if you have any of the
following applications, you can open their respective files in the SIESERVE directory



and see examples of how to use SIEServe data in a spreadsheet or word processing
document:

Application SIESERVE Filename
Microsoft Excel (version 4.0) SIESERVE.XLM
Microsoft Word for Windows (version 2.0) SIESERVE.DOC
Lotus 1-2-3 (version 1.0) SIESERVE.WK3
Quattro Pro (version 1.0) SIESERVE.WB1

You can alter the accompanying files for these applications to suit your needs, or you can
create new spreadsheets and word processing documents, establishing your own DDE
links to the data you want. For information on how to alter or create links from and your
DDE client applications to SIEServe software, refer to the user documentation of those
applications.

10



3 Configuring Your ACCESS System with SIEServe Software

After you experiment with the demonstration program, you are ready to configure
SIEServe software to collect and display real-time data from your own ACCESS system.
In this chapter you will learn how to

e establish communications with an ACCESS system
o add a new device to a system configuration

o save a system configuration

o change an existing device on a system

e delete a device from a system

3.1 Setting Up Communications

Before you configure the SIEServe program to collect data from all of the devices on
your ACCESS system, set the communications parameters for your system. In setting up
communications, you indicate how your computer is physically connected to the SEAbus
communications loop. You identify the serial port on your computer through which it is
connected to your ACCESS system and then identify the baud rate of data transfer on the
SEAbus network. After the communications settings are established, the SIEServe
program can begin polling ACCESS field devices on your system.

This section tells you how to set up communications, and it describes how to use
SIEServe software to operate a dial-up modem if your distribution system is accessible
by modem.

Note: Refer to section 2.2 above for instructions on connecting your PC to the ACCESS
system. Version 1.0 of SIEServe software only allows you to connect directly to your
SEAbus network. Connection through Power Monitor units will be possible in a future
release.

To set up communications, follow these steps:

1. From the Communication menu, select "COM Port . . ." and the COM Port
dialog box appears:

11



rCOM Port] T©"Baud Rate ]

@icomi| O 2400

O com2 ® 4800

O coM3 O 9600

O COM4

O COMS © 19200

O COM6

O com7

O coms

QO CcoM9

2. Select the COM (serial) port through which your computer is connected to the
ACCESS system, or select the COM port to which a modem is connected if
your ACCESS system is set up to communicate via a modem.

3. Select the baud rate of communications on the ACCESS system, and choose
the OK button.

Note: You cannot program the baud rate for your system or for any devices
with SIEServe software; instead, the baud rate you select here in the SIEServe
program must match the baud rate at which your system of devices is set to
communicate. To set the baud rate for field devices, you must follow the
procedure defined for each device. If you are setting up your system and
devices for the first time, make sure that you set all devices for
communication at the same baud rate and then select that same baud rate here
in the SIEServe COM Port dialog box. The following table lists acceptable
baud rates for each ACCESS device.

ACCESS Device Baud Rates
3600 power meter 300, 600, 1200, 2400, 4800, 9600, 19.200
4300 power meter 300, 1200, 2400, 4800, 9600, 19,200
4700 power meter 300, 1200, 2400, 4800, 9600, 19,200

Static Trip III™C trip unit | 2400, 4800

Static Trip IIICP trip unit { 2400, 4800, 9600

SAMMS™ device 4800, 9600

SCOR relay 300, 600, 1200, 2400, 4800, 9600, 19,200
Sensitrip® I trip unit 4800, 9600

Type SB systems breaker | 4800, 9600

12



(For more information about setting the baud rate of ACCESS devices, refer
to the operator's manuals for individual devices and to Siemens' Installing the
ACCESS System [manual no. SG-6028].)

From the Communication menu, select "“Mode . . .", and the Polling Mode
dialog box appears:

Mode
QO Real-Time

® Demo

Real-time mode is the normal mode of operation for SIEServe software to
collect data. Demo mode causes the devices of the present configuration to
appear to be collecting and displaying real-time data.

Select "Real-Time Mode", and choose the OK button.

Select "Save" from the File menu to save the new communications setting for
your system configuration. (If you do not save these settings, the next time
you open this configuration file, the SIEServe program will operate with the
last settings saved and may not be able to communicate with the ACCESS
devices.) If you are saving for the first time to a new configuration file, the
File Save As dialog box appears. Enter a name for your new system
configuration file, and choose the OK button.

13



3.1.1 Dialing a Modem in the SIEServe Program

If you have a dial-up modem connected to your computer, you can use SIEServe
software to dial up an ACCESS system that also has a modem attached. Make sure when
you set up communications as described above that you select the COM port assigned to
your modem. Then follow these steps:

1. From the Communication menu, select "MODEM . . .", and the MODEM
dialog box appears:

Phone number  |123-4567]

2. Enter the telephone number of the modem attached to your ACCESS system.
(If you have special dialing requirements, such as the need to first connect to
an outside line or to use a credit card, refer to Appendix C for information on
modifying the dial string accordingly.) Choose the Dial button, and the Dial
dialog box appears:

MODEM response |ATDT1234567 |

The characters preceding the phone number in the modem response are
modem command characters that are inserted automatically. When you are
connected with the receiving modem, the Dial dialog box closes, and
SIEServe software begins polling the system and collecting real-time data.

3. To save the phone number you have entered as part of this configuration,
choose the OK button and then select "Save" from the File menu.

4. To end communications, choose "Hang up" from the MODEM dialog box.

If you have problems, Appendix C of this manual offers more information about using
SIEServe software with your modem, including information about dialing and
interpreting response messages from the modem. ‘

14



3.2 Adding Devices to Your System Configuration

Follow the procedure in this section anytime you want to add devices to your system
configuration. If you are configuring SIEServe software for the first time, you need to
begin by adding devices to match those of your own ACCESS system.

To add a device to your SIEServe configuration, start the program, and follow these
steps:

1. From the Edit menu, select "Add Device", and the Add Device dialog box
appears:

Device type

Name Device
Address 222

X poll

2. From the pull-down Device Type list, select the type of ACCESS device you
want to add.

3. In the Name field, type a unique name (up to 14 characters) for the new
device. Normally, you want the name to relate to the device's location and
function in your system. This name will appear in the title bar of the device
window and under the its icon. Also, use this name for any DDE links to other
applications.

4. In the Address field, enter the device's unique SEAbus communications
address.

Note: When entering the address of Sensitrip III trip units or Type SB
systems breakers, enter the address of the Multiplexer Translator (M/T) as the
first two digits, and enter the device number of the trip unit or breaker
attached to the M/T as the last digit. SIEServe software does not enable you to
program device addresses; you can only enter an address that is already
programmed into a device. For complete information about communications
addresses for ACCESS devices, refer to the operator's manuals for individual
devices and to Siemens' Installing the ACCESS System (manual no. SG-6028).

5. Ensure that the Poll box is checked, so that SIEServe software can poll the
device for real-time data.

15



Choose the OK button.
7. Repeat steps 1-6 for all ACCESS devices on your system.

When you finish adding devices, select "Save" from the File menu to save the
additions to your system configuration. If you are saving for the first time to a
new configuration file, the File Save As dialog box appears. Enter a name for
your new system configuration file, and choose the OK button.

Once you configure a system in the SIEServe program and save it to a file, you can open
its configuration file after you start the program. From the File menu, select "Open . . .",
and the File Open dialog box appears. Then choose a configuration file from the Files
list. If you have more than one system or configuration file, you might want to create a
program icon for each one, which would enable you to start that configuration from the
Siemens ACCESS program group. To create a program icon for a configuration file,
follow these steps:

1. Go to the Windows Program Manager, and select "New..." from the File
menu. The New Program Object dialog box appears:

New
O Program Group

@éngram tem!

2. Select "Program Item" and choose the OK button. The Program Item
Properties dialog box appears:

Description:

Command Line: I

. Working Directory: | |

Shortcut Key: lNone ]

D_Bun Minimized

3. Inthe Description box, type a name for your configuration. This name will
appear in the title bar of the application window and under the icon for the
configuration.

16



4.

In the Command Line box, type the path to your SIEServe directory, followed
by the program filename (SIEServe. EXE). Then type the configuration
(*.SIE) filename. For example, to create an icon for a configuration file called
"Feeder1" in a directory named C:\SIESERVE, type c:\sieserve\sieserve.exe
feederl.sie in the Command Line box.

In the Working Directory box, type the name of the directory where the
SIEServe program files are located. (C\SIESERVE is the default directory.)

To designate a shortcut key combination for this configuration, enter it in the
Shortcut Key box. This key combination enables you to switch to this
configuration while it is running.

If you need additional help in creating a program item, refer to your Windows
documentation.

3.3 Changing an Existing Device on Your System

Follow the procedure in this section whenever you need to change some configuration
parameter(s) for a device already on your SIEServe system. For example, if you change
the communications address for a particular device, you need to tell the SIEServe
program what the new address is, so that it can continue to communicate with the device

and collect real-time data.

To change any of the configuration parameters for a device, follow these steps:

1.

Make the window of the device you want to change the active window, or
choose its icon from the SIEServe workspace.

From the Edit menu, select "Edit Device...", and the Edit Device dialog box
appears:

Device type
Name Device
Address 222

The Edit Device dialog box contains the same fields as the Add Device dialog
box.

17



3. Make any changes you want to the device type, name, address, or polling
fields.

4. Choose the OK button.

Select "Save" from the File menu to save the device's new settings in your
system configuration.

3.4 Deleting a Device from Your System

The procedure in this section tells you how to delete a device from your system, whether
you actually remove the device from your ACCESS network or you no longer want
SIEServe software to collect data from that device. (If you only want to stop collecting
data from a device temporarily, you can stop the program from polling that device,
instead of deleting it entirely. To turn off polling for a device, make that device the
active window and unselect "Poll" in the Edit Device dialog box.)

To delete a device from the SIEServe program, follow these steps:

1. Make the window of the device you want to delete the active window, or
choose its icon from the SIEServe workspace.

2. From the Edit menu, select "Delete Device", and a dialog box appears asking
you to confirm the deletion:

Delete active Window?

3. Choose the Yes button to delete the device from your system, or choose the
No button to cancel the deletion.

4. Select "Save" from the File menu to save the deletion from your system. If
you do not save these configuration changes, the next time you start the
SIEServe program it will operate with the last configuration saved.

Another way to delete a device from your system is to close the device's window from
the Control-menu box. You can then save this change to your configuration, or you can
restart the SIEServe program without saving any changes, and any device windows you
closed or deleted will remain a part of your configuration.
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4 Using SIEServe Data in Other Applications

One of the greatest values of SIEServe software is its support of dynamic data exchange
(DDE) with other applications that also support DDE. You can use any application that
does support DDE to establish direct links to SIEServe data, so that the client application
constantly receives real-time data from the SIEServe program. To show you how this
works, SIEServe software comes with files from several popular applications. These files
already have links established to the SIEServe Demo configuration. All you need to do is
to start the SIEServe Demo program and open any of these other files to see simulated
real-time data as it is updated in the application.

The SIEServe program disk comes with sample files from these applications:

o Microsoft Excel (version 4.0)

o Microsoft Word for Windows (version 2.0)
o Lotus 1-2-3 for Windows (version 1.0)

¢ Quattro Pro (1.0)

Each spreadsheet contains a sample trend chart, single-line diagram, bar chart, and table
of historical data. The Word for Windows document contains a typical report of
kilowatt-hours, kilowatt demand, and power factor.

4.1 The Microsoft Excel Template

The illustration below shows one example of the many ways you can use SIEServe
software's real-time data.

AMPERAGE

3300
3250
3200
3150
3100

AMPS

ST Wicp
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5 Advanced Uses of SIEServe Software

Although SIEServe software as described up to this point in the manual is quite
powerful, there are still other ways to use it to take full advantage of its capabilities. For
example, on one computer you can use SIEServe software to simultaneously supply real-
time data to as many DDE client applications as your computer's system capability
allows. This chapter briefly describes some of these other uses.

5.1 Running Multiple Copies of SIEServe Software

Windows and SIEServe software allow you to run as many as nine copies of the
SIEServe program simultaneously on the same computer, each using a separate COM
(serial) port. There are two basic reasons that you might want to run multiple copies of
SIEServe program.

First, you may want to communicate with more than one ACCESS system. For example,
you may want to connect to a local network of devices inside your facility and to a
separate, remote network accessible only by dial-up modem. If so, connect and configure
each system as described in chapters 2 and 3 of this manual.

Second, you may want to communicate with only one ACCESS system, such as the
electrical distribution at one plant or facility; however, you might want to monitor parts
of that system separately, or the number of devices may be so large as to slow
communications. For example, if you have a system with 120 devices, it can take an
excessive amount of time to poll every device. Instead of a configuration comprising all
120 devices, you could develop four "subsystems" of 30 devices each, thus speeding up
communications. Whether you want to monitor parts of the system separately or to speed
up communications, the solution is to

1. divide the system among multiple communications loops

2. connect each loop to a separate serial port on the PC (which requires one
RS-232 to RS-485 converter for each loop)

develop separate configuration files for each

4. run multiple copies of the SIEServe program, one for each "subsystem"

To run multiple copies of the SIEServe program, follow these steps:

1. From the Windows Program Manager, open the Siemens ACCESS program
group.
2. Start the SIEServe program.

3. From the SIEServe File menu, select "Open..." and the File Open dialog box
appears:
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Filename: I I

. Directory: c:\sieserve

= Eiles: Directories:
demo.sie [-]
sieserve.sie [-a-]

4. Enter the Filename for the configuration you want to run, or select a file from
the Files list in the dialog box. Choose the OK button.

5. Return to Program Manager and start another copy of the SIEServe program.
Repeat the process for as many copies as your PC is able to run at one time.

You can run each copy of the program with its application window open or minimized to
an icon. If you want to create a separate icon for each configuration, refer to the
procedure at the end of section 3.2 above.

5.2 SIEServe Software and Wonderware's NetDDE

Wonderware Software's NetDDE greatly enhances SIEServe software's ability to deliver
real-time data to a variety of client applications. NetDDE enables you to communicate
simultaneously among a virtually limitless number of Windows, VMS, OS/2, and UNIX
systems.

On a system that contains SIEServe software, NetDDE, and any DDE client applications,
a single SIEServe program can provide real-time data to users on different systems or
platforms running a variety of DDE client applications. Also, a single user can receive
real-time data from multiple SIEServe programs running on one, or more than one,
computer. In short, SIEServe software's ability to deliver its real-time data to any number
of users and to any number of DDE client applications is only limited by the computer
system on which it operates.

5.3 How to View Your System's Data from Anywhere

If you have a dial-up modem on your SIEServe computer and a copy of Symantec
Corporation's pcAnywhere, you can view SIEServe's real-time data from any other
computer running pcAnywhere. A particular advantage of this set-up is to connect your
ACCESS system directly to software support. Your Siemens representative can call up
and view your system without the necessity of a service call. This setup also enables you
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into a spreadsheet the amount of the voltage on phase A of the ACCESS 4700 power
meter mentioned in the preceding paragraph. Select a cell in the Excel spreadsheet, and
type the following character string (which Excel calls a "remote reference formula") in
the formula bar:

Applicationl Topicl Iltem

-s:Leservel feeder 4700" !vphe

/N

Pnpe Single Exclamation
Quoumon Point

In this formula, "sieserve" is the application reference, "feeder 4700" is the unique name
(or ropic) of a particular device, and "vpha" is the item code for the data quantity, voltage
on phase A. (The other characters are necessary components of the formula in Excel.)
You can enter similar formulas in Excel (and other applications supporting DDE) for all
data collected and displayed by SIEServe software. You can also request arrays of all
real-time data for individual devices.

Chapter 5 of this manual briefly discusses the uses of SIEServe data with other
applications, giving examples of DDE conversations for several programs that support
DDE. Consult the user documentation for those programs, or any others, in which you
want to use data from SIEServe software.
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Appendix B: DDE Item Codes for Real-time Data

The tables in this Appendix give you the DDE Item codes for all real-time data for each
device type supported by SIEServe software. Use these item codes in a DDE formula to
provide real-time data in client applications served by SIEServe software.

The item codes, listed in the right column of the tables, are abbreviations of the data
quantities given in the left column of the tables.. Although the codes are written in
upper-case and lower-case letters, you can enter them in a line of DDE code without
regard to case.

In addition to the codes for individual data quantities, SIEServe software provides
several arrays of multiple items. The item code 'devices' provides a one-dimensional
array of the names of all field devices configured on your system. The item code
'realtime’ provides a one-dimensional array of all real-time data for the specified device
type. The item code 'realtime labels' provides a one-dimensional array of labels for all
data quantities provided by the specified device type. The 'realtime’ and 'realtime labels'
arrays vary in size according to device, as shown in the following list:

ACCESS Device Size of Data Array

3600 power meter 1 column by 16 rows
4300 power meter 1 column by 17 rows
4700 power meter 1 column by 23 rows
Static Trip IIIC trip unit 1 column by 9 rows
Static Trip IIICP trip unit 1 column by 29 rows
SCOR relay 1 column by 12 rows
SAMMS device 1 column by 15 rows
Sensitrip I trip unit 1 column by 9 rows
Type SB systems breaker 1 column by 9 rows

Refer to the documentation for each client application, such as Microsoft Excel, for
procedures on creating arrays.
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3600 Power Meter

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Amps Neutral Amp_Neu
Volts Phase A-B VPhAB
Volts Phase B-C VPhBC
Volts Phase C-A VPhCA
Volts Average (L-L) VAvg
Kilowatts KW
Kilowatt Demand KWD
Kilovolt Amps KVar
(Reactive)
Kilovolt Amps KVA
Kilowatt-hours KWHr
Kilovolt Amps KVarHr
(Reactive) Hours
Power Factor PF
Frequency Freq

4700 Power Meter

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Auxiliary Current Input [4Amp_In
Volts Phase A-B VPhAB
Volts Phase B-C VPhBC
Volts Phase C-A VPhCA
Volts Average (L-L) VLLAvg
Volts Phase A VPhA
Volts Phase B VPhB
Volts Phase C VPhC
Volts Average (L-N) VAvg
Auxiliary Voltage Input VAux
Kilowatts KW
Kilowatt Demand KWD
Kilovolt Amps KVar
(Reactive)
Kilovolt Amps KVA
Kilowatt-hours KWHr
Reverse Kilowatt-hours KWRHr
Kilovolt Amps KVarHr
(Reactive) Hours
Power Factor PF
Frequency Freq
Discrete Inputs [1-4] Discrete[1-4]
Discrete Input Counter DiInl_Count
Relay Outputs [1-3] Relay[1-3]

4300 Power Meter

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Volts Phase A-B VPhAB
Volts Phase B-C VPhBC
Volts Phase C-A VPhCA
Volts Average (L-L) VLLAvg
Volts Phase A VPhA
Volts Phase B VPhB
Volts Phase C VPhC
Volts Average (L-N) VAvg.
Kilowatts KW
Kilowatt Demand KWD
Kilowatt-hours KWHr
Power Factor PF

SAMMS Device

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Amps % Unbalance A%Unbal
Winding Temperature Winding_%Temp
Time Until Restart Restart_Time
Elapsed Motor Run Time Elaps_Hrs
Number of Starts Start_Count
Number of Overload Trip_Count
Trips

| Current at Time of Last ATrip

Trip
Pickup PkUp_Text
Microprocessor Watchdog_Text
Watchdog
Motor Status Brkr_Pos_Text
Trip Targets Target_Text
Discrete Inputs [1-4] Discrete[1-4}
Contactor Outputs [1-3] Relay[1-3]
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SCOR Relay

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Amps Ground AGnd
Amp Demand Phase A ADmd_PhA
Amp Demand Phase B ADmd_PhB
Amp Demand Phase C ADmd_PhC
Pickup PkUp_Text
Microprocessor Watchdog_Text
Watchdog
Breaker Position Brkr_Pos_Text
Trip Targets Target_Text

Sensitrip III Trip Unit

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Amps Ground AGnd
Pickup PkUp_Text

Multiplexer Trans.
Comm.

Watchdog_Text

Breaker Position

Brkr_Pos_Text

Trip Targets

Target_Text
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STHIC Trip Unit

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Amps Ground AGnd
Pickup PkUp_Text
Microprocessor Watchdog_Text
Watchdog
Breaker Position Brkr_Pos_Text
Trip Targets Target_Text

Type SB Breaker

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Amps Ground AGnd
Pickup PkUp_ Text
Multiplexer Trans. Watchdog_Text
Comm.
Breaker Position Brkr_Pos_Text
Trip Targets Target Text




STIHICP Trip Unit

Data Quantity Item Code
Amps Phase A APhA
Amps Phase B APhB
Amps Phase C APhC
Amps Average AAvg
Amps Neutral Amp_Neu
Amps Ground AGnd
Amps % Unbalance A%Unbal
Volts Phase A-B VPhAB
Volts Phase B-C VPhBC
Volts Phase C-A VPhCA
Volts Average (L-L) VLLAvg
Volts Phase A VPhA
Volts Phase B VPhB
Volts Phase C VPhC
Volts Average (L-N) VAvg.
Volts % Unbalance V%Unbal
Kilowatts KW
Kilowatt Demand KWD
Kilovolt Amps KVar
(Reactive)
Kilovolt Amps KVA
Kilowatt-hours KWHr
Reverse Kilowatt-hours KWRHr
Kilovolt Amps KVarHr
(Reactive) Hours
Power Factor PF
Frequency Freq
Pickup PkUp_Text
Microprocessor Watchdog_Text
Watchdog .
Breaker Position Brkr_Pos_Text
Trip Targets Target_Text
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Appendix C: Using Your Modem with SIEServe Software

This appendix contains some information that you may find useful when using SIEServe
software to connect to systems accessible by dial-up modem. It lists characters you can
use to modify your dial string, and it defines the modem response messages used by
SIEServe software. It also provides a few brief suggestions for troubleshooting specific
problems. If you don't find the information you need in this appendix, consult the
documentation for your modem(s), or consult a reference source for Hayes compatible
modems.

In some instances, your phone system may require you to do more than enter a telephone
number in the SIEServe program's MODEM dialog box. For example, you may have to
first dial "9" for an outside line at your office. If so, preface the telephone number you
want to dial with the characters "OW", as in this string: 9W18001234567. In this
example, the "9" gives you the outside line, and the "W" instructs the modem to wait for
a second dial tone before continuing to dial. In another example, when you are away
from your plant, you might want to dial up your ACCESS system and charge the long
distance call to a credit card. In this case, you alter the dial string to include the
characters necessary for your long distance service. The following table lists the
characters and definitions dial modifiers recognized by SIEServe software:

Dial Modifier Description
0-9*# Specifies the letters, numbers, and symbols that
ABCD the modem uses when dialing.
T Instructs the modem to dial using the Tone

method. (This character is already a part of the
default dial string in SIEServe software.)
P Instructs the modem to dial using the Pulse
method.
Pauses before continuing the dial string. The
length of this pause is programmed into your
modem; usually, it is 1 or 2 seconds long. For
longer pauses, enter multiple commas or
reprogram your modem.
Waits for another dial tone.
Waits for silent answer from those modems that
do not offer a tone when they answer.
! Issues a hook flash, which is the equivalent of
pressing and quickly releasing the switch hook on
your phone as you would to answer a call waiting.
R Places your call in reverse mode (originates your
call in answer mode), to call an originate-only
modem. This character must be the last one in the
dial string before the carriage return.

; Returns the modem to the command state.
S=n Dials the telephone number # stored in your
modem. (You cannot program telephone numbers
with SIEServe software. Consult your modem's
documentation.)

®|=
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In addition to modifying the dial string with the characters above, you may need to issue
some specific commands to enable your modem to communicate while using SIEServe
software. If you have trouble connecting through your modem, you might try resetting
the modem's factory defaults. To reset them, go to the terminal screen of your
communications software and type "AT&F".

If you have call waiting on the telephone line you use, you should disable it to avoid
interrupting communications, if your phone company supports the ability to disable the
service. You may be able to disable call waiting for the period of one call by beginning
your dial string with "*70,". (If you use pulse dialing, try "1170".)

After dialing, SIEServe software shows you the modem response in the Dial dialog box.
The following table presents a complete list of the modem responses and their
descriptions for SIEServe software.

Response Description

OK Command executed successfully.

CONNECT Connected to receiving modem.

RING Ring signal detected.

NO CARRIER Carrier signal was not detected or was lost. Ora

period of inactivity, which was longer than the
time set in the time-out register, caused the
modem to hang up.

ERROR Invalid command, invalid checksum, error in the
command line, or the command line exceeds 255
characters.

NOQO DIALTONE No dial tone detected on your phone line.

BUSY The receiving modem or phone line is engaged.

NO ANSWER No silence detected from a system not providing a

dial tone. (This response comes only when you
use the @ modifier.
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